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Nothing can conjure a certain mood like a 
hand-tinted photograph with the soft scratches 
and spots that come with age. Unless you have 
the time to paw through every photo bin in an 
antiques store to fi nd just the right image, try 
this Photoshop tutorial on creating a vintage 
look. 

In this tutorial, you will learn how to cre-
ate the look of an aged, hand-tinted photograph 
(Figure 1) by using Photoshop’s masks, fi ll and 
adjustment layers, blending modes, and layer 
styles.

distressed-looking outer border of the photo-
graph. The main thing to remember when mask-
ing is that white reveals and black conceals.

Photoshop comes with a large array of 
brush presets. You can access the brushes by 
selecting the Brush tool and opening the Brush-
es Presets picker on the left side of the options 
bar next to the word Brush, or by opening the 
Brushes palette by pressing F5, or clicking on 
the Brushes palette icon near the right end of 
the options bar.

To create the distressed look of the bor-
der, you will be using brushes you can refer to 
as texture/grunge brushes. Photoshop assigns 
these artistic names such as Chalk, Rolled Rag, 
Sponge, and so on. Some of these are available 
in Photoshop’s default set of brushes. For a wid-
er range of brushes, click on the small triangle 
in the upper right of the Brushes Preset picker 
and choose Faux Finish Brushes from the drop-
down menu. When the dialog appears, choose 
Append and click OK. You can also create your 
own grunge brushes, and numerous Web sites 
offer free brushes that you can load into Photo-
shop to greatly increase your brushes arsenal.
Step 1 - Open the image you downloaded that’s 
called Bike.tif. Double-click on the background 
layer and rename it “bike”.
Step 2 - Add a layer mask by clicking on the Add 
Layer Mask button at the bottom of the Layers 
palette. Make your foreground color black. 
Step 3 - From the Brushes Presets choose the 
brush named Chalk. It may help if you choose 
Large List (Figure 2) from the drop down menu. 
This will provide you with the names of the 
brushes as well as the icons for the various 
brushes.

FIGURE 1. HERE IS THE PHOTO BEFORE AFTER YOU MA-
NIPULATE IT IN PHOTOSHOP.

This composition is the fi rst in a series to 
create for a bound collection of postcards using 
the images of a talented photographer from. First, 
download the fi les from the folder on Drive S.

Getting Started
You should learn to work nondestructive-

ly. That means working in a way that keeps your 
options open and allows you to make changes 
quickly and easily, without damaging your origi-
nal image. To work nondestructively you need 
to use masks. The fi rst thing you will do in this 
tutorial is use a layer mask to create the aged, 
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FIGURE 2. CHOOSE LARGE LIST FROM THE BRUSHES 
PRESETS DROP DOWN MENU.
Step 4  - Make the brush about 100px in diam-
eter. You can use either the Standard or the Air-
brush mode for this project. Out of habit I tend 
to use Airbrush most of the time. If you use 
Standard mode, reduce the brush opacity in the 
options bar to about 30%. If you use the Air-
brush mode, reduce the fl ow to 30%. It’s easy if 
you stick to one or the other.
Step 5 - Be sure the foreground color is black 
(remember, black conceals). Use a series of 
strokes and scrubbing motions to mask the edge 
of the photo (Figure 3). Do not try to create the 
effect using only one brush or one size of a par-
ticular brush. Vary the brushes and sizes quite 
a bit to get an irregular, organic-looking edge. 
Some of the other brushes that were used in 
the illustrations in this project were Rolled Rag, 
Sponge, and Stencil Spray Wet. You may want 
to duplicate the layer several times (Control-J) 
and repeat the process several times until you 
get something you like. There is no one abso-
lutely correct answer. This is art, after all.

 

FIGURE 3. USE DIFFERENT TYPES AND SIZES OF BRUSHES 
FOR A MORE ORGANIC BORDER.

Creating a good distressed border takes 
some practice and experimentation. Don’t get 
discouraged if yours doesn’t look like the sam-
ple illustration right off the bat.
Step 6 - Add a solid color fi ll layer by clicking 
on the Create New Fill or Adjustment Layer but-
ton at the bottom of the layers palette. Choose 
Solid Color at the top of the menu (Figure 4).

FIGURE 4. ADD A SOLID COLOR FILL LAYER.

Step 7 - When the Color Picker appears, choose 
a light to middle value warm grey and click OK. 
Move the fi ll layer below “bike” in the layers pal-
ette stack (Figure 5).
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FIGURE 5. CHANGE THE FILL COLOR AND MAKE IT THE 
BOTTOM LAYER.
Step 8 - Save your document as Postcard.psd.

Set the Mood and Focus Attention
Step 9 - Add a levels adjustment layer (Layer 
> New Adjustment Layer > Levels). Lighten the 
entire image by moving the right and middle 
sliders to the left until the Input Levels at the 
top of the dialog read approximately 0, 1.44, 
and 196 (Figure 6).

FIGURE 7. YOUR PHOTO AND MASK SHOULD RESEMBLE 
THIS.

Note: You can view just the mask by 
pressing Option (Alt on the PC) and clicking on 
the thumbnail of the mask in the layers pal-
ette.

Add a Hand-Tinted Look
Step 12 - Use the Create New Adjustment Lay-
er icon to make a new solid color fi ll layer above 
the levels adjustment layer. Choose a turquoise 
color from the Color Picker (try 86, 215, 243). 
Change the layer’s blending mode at the top 
of the Layers palette to Color and reduce the 
Opacity to 14%.
Step 13 - This next bit sounds a little confusing 
at fi rst, but it’s a very useful technique that you 
need to learn. Highlight the layer mask on the 
new colored fi ll layer, then Control-click on the 
thumbnail of the level’s adjustment layer mask. 
That will create a selection based on the level’s 
mask.
Step 14 - Fill the selection on the fi ll layer’s 
mask with black (Figure 8). This will hide the 
turquoise in the center portion of the image and 
leave it around the edges. Soften the edges of 
the mask using one of the texture brushes with 
a diameter of about 80px on a Flow or Opac-
ity setting of about 30%. If the turquoise ap-
pears in the center of the image rather than the 
around the outside, press Control-I to invert the 
mask.

 

FIGURE 6. THE LEVELS DIALOG BOX.
Step 10 - Go to Edit > Fill and choose Fore-
ground Color if your foreground color is current-
ly black, otherwise choose Black from the drop 
down menu. This will completely hide the effect 
you just created.
Step 11 - Change your foreground color to 
white (white reveals) and use one of the tex-
ture/grunge brushes (Chalk, for example) to se-
lectively reveal the effect. Concentrate mainly on 
the center of the image. Leave the edges dark. 
Now your image should look something like the 
left pane of Figure 7, and the mask should look 
like the pane on the right.

 

FIGURE 8. THE EDGES HAVE A TURQUOISE TINGE TO THEM 
NOW. CLICK ON THE IMAGE TO SEE A LARGER VERSION.
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Step 15 - Next, give everything a warm, aged 
tone by adding a new adjustment layer. This time 
choose Photo Filter from the Adjustment Layer 
menu and select Warm Filter 85 from the fi lter’s 
drop down menu. Change the Layer opacity to 
60% (Figure 9).

 

Step 17 - Open the Channels palette. Click on 
the small triangle in the upper right corner of the 
palette and from the drop-down menu choose 
New Channel (Figure 11). Name the channel 
“abstract”. In the dialog under Color Indicates, 
choose Selected Area and click OK. You have 
just created an alpha channel.

 

FIGURE 9. ADD A NEW ADJUSTMENT LAYER AND CHOOSE 
PHOTO FILTER.

Add the Look of Water Damage
An important note about masking: When 

you make a selection and then add a mask, 
the area inside the selection will be white (RE-
VEALED) and the area outside the selection will 
be black (HIDDEN). In the next steps you will 
use this feature with an adjustment layer to add 
texture to the image, creating the appearance 
of water damage. These steps will be easier if 
you undock the Layers and Channels palettes so 
that you can see both at the same time.
Step 16

Open Abstract.tiff (Figure 10) and Select 
All (Control-A). Copy the selection (Control-C) 
then go back to Postcard.psd.

 
FIGURE 10. THE IMAGE CALLED ABSTRACT.TIFF.

FIGURE 11. NOW YOU’LL WORK IN THE CHANNELS PAL-
ETTE.
Step 18 - When you click OK, the image win-
dow will be completely white. That’s because 
what you are seeing is the new channel, not the 
images in your Layers palette. Paste the image 
you copied from Abstract.tiff into the new chan-
nel (Control-V).
Step 19

Use Free Transform (Control-T) to reduce 
the size and rotate the image to your liking. 
Click the box next to the RGB channel to turn 
on the eyeball. This will cause your alpha chan-
nel to appear red in the image window with the 
rest of the image visible below or behind it, al-
lowing you to see how the alpha channel relates 
to the rest of the composition as you size it. I 
scaled the abstract texture to 57%. When you 
are happy with the way the texture relates to 
the photo of the bike, click the Check Mark in 
the Options bar.
Step 20 - Highlight the RGB composite chan-
nel. This should automatically hide the new al-
pha channel. If not, click the eyeball next to the 
alpha channel. Load the channel as a selection 
by (Control-click) on the thumbnail of the new 
alpha channel in the Channels palette.
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Step 21 - Go back to the Layers palette and 
add a curves adjustment layer. Name the lay-
er “abstract texture”. Now here’s an important 
point: Adjustment layers automatically come 
with layer masks and, as I said at the beginning 
of this section, when you have an active selec-
tion and add a mask, only the area inside the 
selection will be revealed. That means when the 
Curves adjustment layer is created it will have a 
mask based on the alpha channel selection you 
just made. As you modify the adjustment layer, 
only the area inside the selection will affect the 
image below. Click on the curve in the Curves 
interface to add a point and move the point to-
ward the upper left corner. To increase the ef-
fect, add a second point and move it up and to 
the left as shown in (Figure 12). A texture will 
appear on the image.

 

Now you will create the title and the kanji 
(Japanese character) to the left of it using Pho-
toshop’s Type tool, Layer styles, and the Distort 
fi lter. Then you will add a few fi nishing touches 
with the Shape and Painting tools.

Create the Title Treatment
Step 1 - Open the Postcard.psd fi le you created 
in Part 1. Select Photoshop’s Horizontal Type 
tool. Choose a font you like. I chose Trajan Pro 
bold. Click on the Color Swatch in the options 
bar and move your cursor over the image. The 
cursor changes to the eyedropper tool. Sample 
a warm light gray from within the image. Click 
in the image window and type OKAYAMA. Make 
the initial cap about 84.5 points and the other 
letters about 60 points. Reduce the Layer opac-
ity of the new Type layer to 74% and change the 
blending mode to Hard Light (Figure 2).

 

FIGURE 12. FURTHER CHANGE THE IMAGE USING A 
CURVES ADJUSTMENT LAYER

Step 22 - For an even more dramatic effect, 
duplicate the Curves layer. Change the blending 
mode of the copy layer to Color Burn and reduce 
the layer opacity to 50%

You have now reached a major point. It 
would be a good time to review the steps you 
have taken up to this point, before you pro-
ceed.

FIGURE 2. THIS TYPE IDENTIFIES WHERE THE PHOTO 
WAS TAKEN: OKAYAMA, JAPAN.

Step 2 - At the moment the type is too clean-
looking compared to the rest of the composi-
tion. Here’s a little trick that will quickly give the 
type a distressed look. Load the type as a selec-
tion (Control-click) on the T symbol in the Lay-
ers palette. Make a new layer. Name it stroke. 
Make your foreground color black. Go to Edit > 
Stroke and apply a 3px stroke to the outside of 
the selection. Deselect (Control-D).
Step 3 - Go to Filter > Distort > Ripple. Make 
the amount about -714 and select small from 
the Size drop-down menu; then click OK (Figure 
3). Hide the layer by clicking on the eyeball next 
to the layer in the Layers palette.



PS622 - ANTIQUATING A PHOTOGRAPH IN PHOTOSHOP                             6 N/08/08

 
FIGURE 3. A DISTORT FILTER STARTS TO MAKE THE TYPE 
LOOK MORE IN KEEPING WITH THE AGED LOOK OF THE 
IMAGE.
Step 4 - To distress the edge of the type, high-
light the Type layer and add a Layer mask. Load 
the distorted stroke as a selection (Control-click) 
on the stroke layer. With the Type layer mask 
highlighted, use black and soft round brush 
(about 65px) with a fl ow or opacity of 45% and 
begin masking the edges of the letters. Press 
Control-H to hide the marching ants so you can 
more easily see the results of the masking.
Step 5 - To fade the type in and out, deselect, 
then increase the size of your brush to 125px. 
Uncheck Shape Dynamic in the Brushes palette 
(press F5 to open the Brushes palette). Lower 
the fl ow or brush opacity to about 7%. Ran-
domly paint on the mask, decreasing the opac-
ity more in some areas with overlapping strokes 
(Figure 4).

 

FIGURE 5. THE LAYER STYLE DIALOG BOX.
At the top of the Layers palette, just be-

low Opacity, is Fill. Reduce the fi ll of this layer 
to 0%. That will cause the type itself to disap-
pear, but the stroke will remain visible. Make 
the Layer Opacity 35% and change the blending 
mode to Multiply.
Step 7 - Next you will separate the title some-
what from the background and accentuate the 
illuminated quality of the composition by adding 
highlights to the title. 

Make a new layer above OKAYAMA copy 
and name it “highlights”. Load OKAYAMA as a 
selection by Control-clicking on the T symbol 
in the OKAYAMA copy layer. Choose a large 
(100px) round soft brush with a fl ow or brush 
opacity setting of about 10%. Make the fore-
ground color white and lightly paint the top and 
right portions of the selection, gradually adding 
highlights to the type (Figure 6).

 

FIGURE 4. DON’T BE TOO PRECISE AS YOU DECREASE 
THE TYPE’S OPACITY IN SOME PLACES.
Step 6 - Duplicate the layer and, with the lower 
layer highlighted, click on the Add a layer style 
button (the circled f icon) at the bottom of the 
Layers palette to access the Layers styles menu. 
Choose Stroke. Make the stroke 2px wide, 100% 
opaque black (Figure 5). Click OK. 

 

FIGURE 6. AS YOU ADD HIGHLIGHTS TO THE TYPE, IT 
WILL APPEAR MORE ORGANIC AND INTERESTING.

Step 8 - Reduce the Layer opacity if needed and 
change the blending mode to Color Dodge.

Create the Kanji 
Kanji is the Japanese name for the char-

acters that are an integral part of the Japanese 
writing system. Adding such a character to the 
composition will immediately tell the viewer, 
“This is Asia.” The particular kanji you will be 
using in these steps means “tranquil” or “calm.” 
You will create the kanji much as you did the 
look of water damage in Part 1 -- by using an 
alpha channel selection.
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Step 9 - Find the fi les you downloaded in part 
1 and open the image Kanji.tif. Select All and 
Copy. Go back to Postcard.psd. Click on the small 
triangle in the upper right corner of the Chan-
nels palette and choose New Channel. Name 
the channel “kanji” and under Color Indicates, 
choose Selected Area and click OK.
Step 10 - Load the kanji alpha channel as a 
selection (Figure 7). 

Add Texture to the Kanji 
Pattern fi ll layers are a great way to add 

an organic quality to an otherwise fl at-looking 
object.
Step 12 - Control-click on the thumbnail in the 
kanji layer to load it as a selection. Click on the 
Create a New Fill or Adjustment Layer button at 
the bottom of the layers palette. Choose Pattern 
up near the top of the menu. When the Pat-
tern dialog appears, click on the Pattern Swatch 
(Figure 9). This will open the Pattern Presets 
palette. Click on the small triangle in the up-
per right corner and from the drop-down menu 
choose Artistic Surfaces. When Photoshop asks 
if you want to replace current patterns, click 
Append. This will add the Artistic Surfaces col-
lection of patterns to the Pattern presets. Then 
select Wax Crayon on Vellum and click OK.

 

 
FIGURE 7. THE CHANNELS PALETTE ONCE YOU’VE LOAD-
ED THE KANJI ALPHA CHANNEL.

Make the RGB channel active and hide 
the kanji channel. In the Layers palette, high-
light the layer abstract texture, then add a solid 
color fi ll layer from the fi ll and adjustment layer 
menu at the bottom of the Layers palette. Name 
the new fi ll layer “kanji”. When the Color Pick 
appears, move your cursor over the image and 
sample a medium warm grey from within the 
image. Click OK.
Step 11 - Scale the kanji to about 57% and po-
sition it in the upper left corner slightly behind 
the O in OKAYAMA (Figure 8).

 
FIGURE 8. THE KANJI IS BEGINNING TO LOOK MORE IN-
TEGRATED INTO YOUR COMPOSITION.

FIGURE 9. ADD A PATTERN TO THE KANJI.

The kanji now has texture and blends 
nicely with the rest of the composition (Figure 
10).
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FIGURE 10. THE WAX CRAYON ON VELLUM PATTERN 
GIVES THE KANJI A NICE TEXTURE.

Finishing Touches
You will fi nish the composition by adding 

a black Shape at the bottom to give the com-
position structure, contrast, a place for the eyes 
to rest, and a non-busy background in which to 
put descriptive information.
Step 13 - Select the Rectangle Shape tool (just 
below the Type tool). In the options bar make 
sure Shape Layers is selected on the far left. 
Click on the Color Swatch in the Options bar and 
pick black in the Color Picker. Make a rectangu-
lar shape at the bottom of the composition, ap-
proximately 0.65 inches high (Figure 11).

 

FIGURE 12. NOTE THE POSITIONING OF THE TEXT ELE-
MENTS YOU’RE ADDING IN THIS STEP. 

Step 15 - Next, you will create a very narrow 
horizontal rectangle shape. The point of this 
shape is simply to add interest with an addi-
tional design element and place emphasis on 
the words “Images of”. Choose a light warm 
grey and, with the Rectangle Shape tool, make 
a shape about 0.020 inches high. It needs to 
go from the left edge to just beyond the O in 
“Okayama”. 

Position the shape so it appears just 
above “Images of” in the image window. In the 
Layers palette, put the Shape layer below the 
layer “Images of”. Add a layer mask. Make the 
foreground color black and use a brush or linear 
gradient to mask out the left and right sides of 
the shape, blending the shape into the back-
ground.
Step 16 - Finally, you will create the red stamp 
in the lower right. In addition to being remi-
niscent of the wax stamps the Japanese use 
as signatures, the red is a nice accent color. 
The symbols in the stamp represent the name 
“Okayama” written in kanji. 

Open Stamp.tif and follow the same pro-
cedure you used for making the kanji. Choose 
red for the Solid Color fi ll layer. Use Free Trans-
form to rotate the stamp slightly. Add a layer 
mask and use a texture brush to distress the 
stamp and blend it with the background.

FIGURE 11. ADD A SHAPE LAYER.
Step 14 - Select the Horizontal Type tool and a 
font you like; This sample is Post Antiqua (Bold 
and Roman) but you may choose any similar 
face. Create separate Type layers for each of 
the following lines of copy and position them as 
shown in Figure 12: 

• Images of [12 points, Bold]
• January 2006 [10 points, Roman]
• A unique eye captures the seasons 

of Japan in the Land of Sunshine - Okayama [8 
points, Roman]
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FIGURE 13. THE FINAL IMAGE:


